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A back-to-basic approach with enhanced
capabilities....

*For Windows 3.x, Win NT, Windows 95 and WFWG optionally
running in a Novell network .

Wconvert / for prior users of Winmenu...

Menu Lines How to add, change, delete or move menu line items.

File Menu A look to the File menu.
Options Menu Your options under the Option menu.
Accessories Menu How to access programs in the blue ribbon.

Sections Menu  What the Sections menu does.
The TITLE= parameter Display your company name.

How to setup Winmenu as the Windows Shell

Executing programs automatically at startup

Date and Time. Changing the display settings

Customizing Winmenu. The [Options] section.

Changing the description of the pages

The "Video Screen" button

Visit our World Wide Web page at:
http://www.halcyon.com/Winmenu/WWW/winmenu.html for the latest
information on Winmenu . You may also download the latest copy as they
become available. Check out also the Corporate Edition of Winmenu for
Novell LANs. Send comments/questions to Ricky Freyre at the Internet
mail address: 70154.2635@compuserve.com






Adding a new menu item

You may double click over the empty menu line or enter the menu number in the input
box and press the ENTER key. Attempting to execute an empty menu line will
automatically display the Menu Entry window . This window allow you to define the
menu item information.

DRAG-AND-DROP

You may also add new menu items by "dragging"” with your mouse the selected file(s)
from the File Manager. While Winmenu is minimized, just select the desired file(s) in
the File Manager and drag-and-drop them on top of Winmenu's minimized ICON.
Winmenu will scan for the next available menu space (unless you had a empty menu
space already highlighted) and will add the dropped file to this space. If you had an
empty menu space highlighted, Winmenu will add the dropped files starting at that
menu space number.

If you are running Winmenu Network Edition

Note: Changing,adding and moving menu items is restricted by your network
administrator.

You can only do changes to your personal menu(s). Contact your administrator for more
information.




Changing a menu item

Click once and highlight the desired menu line to review or change and then select the
Add/Review option from the Options menu. Or, enter the menu line number in the input
box and press CTRL+A. If this menu item has a password defined, WinMenu will prompt
you for the password. The Menu Entry dialog will be displayed.

If you are running Winmenu Network Edition

Note: Changing,adding and moving menu items is restricted by your network
administrator.

You can only do changes to your personal menu(s). Contact your administrator for more
information.




Moving a menu item

If you like drag-and-drop...

Winmenu allow easy move of menu items in a menu section via drag-and-drop
technology. To move an menu item, point the mouse over the menu item you wish to
move and hold the left mouse button down. Move the mouse to the desired menu item
position and release the left mouse button. To move across pages, do the same but
move the mouse over the desired page button while holding the left button down . This
will change the page while still dragging the menu item. Release the item over the
desired menu position.

Otherwise...

Enter or highlight the menu line number to move and press CTRL+V . A small window
will pop-up and prompt you for the destination line number to move the selected menu.

You can only move menu items within the current menu section_. If a menu item already
exist in the destination, then Winmenu will swap menu items.

If you are running Winmenu Network Edition

Note: Changing,adding and moving menu items is restricted by your network
administrator.

You can only do changes to your personal menu(s). Contact your administrator for more
information.




Deleting a menu item
If you like drag-and-drop...

Point the mouse over the menu item you wish to delete and hold the left mouse button
down. Move the mouse to the TRASH can picture located at the bottom right of the menu
display. Release the left mouse button. Wimenu will prompt you for confirmation.

NOTE: The TRASH can will only show when you are allowed to delete menu items. User's
of the Corporate edition can only delete items in their personal menus.

Otherwise...

Click once over the menu line to highlight the desired menu to delete and then select
the Delete menu option from the Options menu. Or enter the menu line number in the
input box and press CTRL+A. If this menu item has a password defined, WinMenu will
prompt you for the password. The Menu Entry dialog will be displayed. Just press the
DELETE button to delete the current menu item.

If you are running Winmenu Network Edition:

Note: Changing,adding and moving menu items is restricted by your network
administrator.

You can only do changes to your personal menu(s). Contact your administrator for more
information.




The Accessories menu and the Blue Ribbon

The blue ribbon is displayed at the top of the WinMenu screen. It contains up to nine
utility program icons which are defined in the accessories menu. These programs can be
quickly executed by a click of the mouse or via the system menu while Winmenu is
minimized. The blue ribbon programs can be customized by the users. This is a good
place to define frequently run programs like your electronic mail application. These
programs can also be executed from the Accessories menu. Changing or adding a blue
ribbon program also modifies the Accessories menu and the system menu. Note for
Network users: The accessories are defined by the network administrator. Network
users can not change and configure their accessories at their workstation.

To change a blue ribbon program:

Open the FILE menu and select "Edit Accessories..." .

Acceseonl 1
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Command Line:  [C:ywWINDIMSWCLOCE. EXE |
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Click once over the accessory button you wish to create or update. Fill in a short
description and the filename information. You may use the Browse button to browse the
hard disk files. Winmenu automatically extracts the associated ICON from the program
file. Use the Change Icon button if you want to associate another ICON to the program.
Press the SET button to store the accessory program information. Repeat these
steps for each accessory you wish to add or change.

To delete a blue ribbon program:
At the "short description”, enter the word UNDEFINED. Click the SET button to save.

The word UNDEFINED automatically disables that particular ribbon program. Winmenu
will display the EMPTY.ICO included with the Winmenu files. If not found, no icon will be
displayed. When theuser clickover the disabled ribbon program space, Winmenu makes a
small beep and ignores the action.

D mecription: I':I"d

Creating or changing an accessory program.



Auto Minimize

The Auto Minimize option can be enabled or disabled from the Options menu. This
feature allows you to automatically minimize Winmenu when executing any program. If
this option is disabled, Winmenu will remain open at all times unless you manually
minimize the window. To enable the auto minimize option, open the Option menu and
verify that the Auto Minimize is marked. If not marked, click once over the menu
option. To disable, click over the marked menu option.

Winmenu enables the auto minimize option as the default when installed. Combine with
the Auto Restore option, Winmenu better simulates a conventional menu that closes and
automatically opens after the application has executed.



Auto Restore

The Auto Restore option can be enabled or disabled from the Options menu. This
feature allows you to automatically maximize or display Winmenu when all running
applications have ended or are minimized. If this option is disabled and Winmenu is
minimized, you would have to double click over the Winmenu icon to display the menu
again. To enable the auto restore option, open the Option menu and verify that the
Auto Restore is marked. If not marked, click once overthe menu option to mark it.
To disable, click over the marked menu option.

Winmenu enables the auto restore option as the default when installed.



Verify Instances

The Verify Instances option can be enabled or disabled from the Options menu. This
feature allows Winmenu to monitor all running applications to detect multiple instances
or copies of the application you are about to execute. If the application is already
running, Winmenu gives you the option to recall the running application or execute
another copy or instance. If multiple instances of the same application were running,

Winmenu would create and display a pop-up menu with the running instances to allow
you easy recalling.

Winmenu enables the Multiple Instances option as the default when installed.

= WINMENU

Press "YES' to recall ,
or '"NO' to run a new instance.

® Application NOTEPAD.EXE is already runningl.




Menu Lines

Adding a menu item

Changing a menu item

Deleting a menu item

Moving a menu item

Importing Program manager groups to Winmenu




Options

Add/Review menu items

Move Menu ltem

Rename pages

Auto Minimize
Auto Restore
Verify Instances

Sound
Turn vellow windows ON/OFF

Note: Some of the above options may have been restricted by the administrator for users
of Winmenu Corporate Edition.



File Menu

Run - Click over the Run option to display the Run Window. This window allows you to
browse the directories and execute any file.

Exit - click over the exit option to terminate Winmenu session.

Enter Registration - Use this option when you have registered Winmenu and you have
received your registration number.

Edit Accessories - Allows you to change the blue ribbon accessories. These are up to
nine of your most frequently used programs that can be executed quickly from Winmenu.

Edit Sections - This option allows you to create or delete menu sections. Each menu
section can hold four pages of menu items. Up to 30 menu sections can be defined.

About - This option display additional system information and the author name.

Note: Some of the above options may be have been restricted by the administrator for
users of Winmenu Corporate Edition.



Sections Menu

Winmenu can optionally organize your menu items into menu sections (i,e Word
Processing, Finance, Communications, etc..) . Each menu section can hold up to 72 menu
items divided into four pages. Winmenu allows you to select the desired menu section
from the "Sections" menu or by selecting the section name from the main screen.

Note: The "Sections" menu will be grayed when only one menu section exist because
that section becomes the default.

&

If you are running the Network edition, all your menu section names are created and
assigned for you by your network administrator. Winmenu will only show to you those
menu sections that you are authorized to use. The information below is only usefull
when running Winmenu in standalone mode.

Users running the Winmenu standalone version have the option to define their own
menu section's names. Most users do not need more that one or two menu sections.
In fact, if you do not need more than 72 menu items, you may not need to define any
menu section. See Changing the description of the pages to further organize a single
menu section. In any event, defining menu sections is optional.

b

You may also import your existing Program Manager groups in Winmenu.  This is kind
of a neat feature. You may use the Program Manager to create a group with the desired
applications (up to 72 apps per group) and use that group in Winmenu . Once you
have created the group in PM, you must copy the desired GRP file(s) from your \
WINDOWS directory into your \WINMENU directory. Incorporate the GRP files in
Winmenu by using the "Edit Sections.." option of the FILE menu. See below.

&

Winmenu will not allow you to incorporate a .GRP file directly from the \WINDOWS
directory because the GRP file will eventually be transformed by Winmenu to something
not compatible with Program Manager. Hence, do not copy .GRP files used in
Winmenu to your \WINDOWS directory because Program Manager will not read them
back.

FOR USERS RUNNING THE STANDALONE VERSION

The menu section window can be accessed from the "Edit Sections.." under the FILE
menu.

I To create or add a menu section name.

You must enter a short descripton for the menu section name in the Section Name 's field
and also enter the associated .GRP file name. Winmenu stores and maintain the
associated menu items in this GRP file. The GRP filename must be a valid DOS file name
and must end with the extension .GRP. Examples: WORDPRO.GRP, GAMES.GRP,
UTILITY.GRP , C:\SECTIONS\MGMT.GRP. You may click the BROWSE button to browse your
directories and select existing .GRP files. The .GRP file do not have to exist at this time
but the name should be a valid DOS filename. The directory path is optional . You may not
enter a GRP file that already shows in the list.  You may not use a GRP file that resides in
your \WINDOWS directory. Click the ADD/CHANGE button to add the menu section name
when ready.




&

Note: The .GRP file are automatically created and maintained in the same directory
where WINMENU.EXE resides unless you have also specified a complete directory path.
| recommend not to specify a directory path with your GRP file names and allow all your
GRP files to exist in the Winmenu's directory. This is the default and also the most
sensitive way to ease the maintenance task.

(=5 To change or delete a menu section name.
To change an existing menu section name, open the FILE menu and click over the "Edit
Sections..." menu option. This will bring up the Sections window which allows you to

change or add menu section names.
Click over the desired menu section name from the list.of menu sections shown. Make

the desired changes or click the DELETE button. When making changes, you must click
the "Add/Change" button to save those changes.

EE To reorder the menu section names.

You may drag-and-drop the section names to the desired position in the list. Click and
hold down the right mouse over the desired menu section line to move and drag the
mouse to the desired position. Release the mouse and the selected line will be inserted
in that position. All other lines will shift down. To move a line to the end of the list, just

drop the drag mouse after the last line.
Winmenu has a maximum of 30 menu sections !!!.
Click OK when done .



Menu Entry Dialog

The Menu Entry Dialog
= A Menu ltem's Maintenace
Item Mo: 2 E

Description: IlEumpuSEl‘l’E |

Command Line:|C:\CSERVE \WINCIM\WINCIM.EXE |

Work Directory:[C:\CSERVE\WINCIM |

Password:[UNLOCK | [ Run Minimized

I (0] 4 Browse Delete Cancel Change lcon

Command Line - Enter the full command line to execute the desired application. You
must also include any parameters needed. Example: MSMAIL.EXE

Work Directory - Enter the default directory or path for the application. This is optional.
Winmenu will made the directory the current default directory before executing the
command line. Example: C:\MSMAIL

NOTE: Winmenu also support automatic insertion of environment variables. Any word
between the percentage characters (%) is interpreted at execution time. Winmenu will
replace the %variablename% with the corresponding value found in the environment.

If none found, Winmenu replaces the %variablename% with a space. NOTE: This
feature is only available for the fields Command Line and Work Directory. Also, the
variable search is case sensitive. (Upper and lower case letter are not the same).

Password - Enter desired password. This is also optional. Winmenu will require entering
this password before executing the command line or opening the Menu Entry dialog.

Run Minimized - When marked, this indicate WinMenu to execute the application as an
ICON. Leave unmarked for normal execution.

Press the OK button when finished, CANCEL to abort changes, BROWSE to pop-up a
window that helps locate files. Note: the DELETE button is disabled when entering new

menu items.
The Change Icon button allows you to setup or "attach" an ICON to the menu line for

displaying . Just select the desired ICON or click the browse button to extract the icon
from another file. NOTE: make sure the file is available for the users.



The menu item will be saved under the current menu section .



The "Video Screen" button

The "video screen" button or menu selection allows users to immediately invoke their
favorite screen saver. The option can be accessed from the accessories menu, the
main display or while Winmenu is minimized using the system menu. Itis
recommended that you set up your screen saver to ask for a password. This way, you
may use your screen saver as a security layer. So, next time you are working on a
sensitive e-mail and the phone rings or you need to walk out, click over the "Video
Screen" button to hide your display and secure your workstation. NOTE: you may setup
your screen saver in the Desktop option of the the Control Panel.



The TITLE= parameter

The TITLE= parameter allows you to display your name or company name in the
Windows top title bar. Use can use your favorite text editor to open the file
WINMENU.INI and insert the following line under the [Options] section:

[Options]

Title=My Company Name, Inc.
etc.

etc.



Sound

Winmenu has the capability to do event sound effects. If you have a sound card or the
speaker.drv installed in your workstation, you may enable this option. This option can
be turn ON or OFF from the "Options" menu .



Executing programs at startup

NOTE: As the Windows shell, Winmenu will automatically execute the programs
defined in the "startup" group of Program Manager. All you need to do, is to define the
desired programs in the startup window group of Program Manager and execute
Winmenu as the shell.

See also How to setup Winmenu as the Windows Shell

The RUN= and LOAD= commands in WIN.INI

Winmenu will also executed automatically the program specified in the LOAD= and
RUN= lines of WIN.INI file. The LOAD= will execute the program(s) as minimized
applications. The RUN= executes the program(s) as normal applications.



The Date and Time box

Winmenu displays a small box with the current date and time on the main screen. The
international settings in your Windows control panel are used to display the date and
time. To change this settings, open the windows control panel (or execute
CONTROL.EXE from the RUN window) and double-click over the "International" ICON.
Make the desired changes to the date format and time format boxes. NOTE: Only the
short date format is used to display Winmenu's date.



Customizing Winmenu. The [Options] section.

The [Options] section can manually be entered in the WINMENU.INI file. It is used
internally by Winmenu to change or define the following options. You may also change
the page descriptions for each menu section by adding or modifying the [Config] section.
See Changing the description of the pages

[Options]
AutoRestore=1
AutoMinimize=1
MIV=1

etc.

(Note: the only possible values are 1 for ENABLED and 0 (zero) for DISABLED. Except for
the Drive= parameter.)

AutoRestore= If WinMenu is minimized and all other Windows applications are closed
or minimized, then Winmenu automatically opens the menu . Usually used in
combination with AutoMinimize option. The default is ENABLED.

AutoMiniMize= It automatically minimize WinMenu when the user executes another
application from within Winmenu. The default is ENABLED.

ConfirmExit=If enabled (=1), Winmenu will ask the user to confirm when exiting
Windows. The default is DISABLED.

MIV= This is the Multiple Instance Verification. Each time the user executes an
application, Winmenu can verify if that application is already running. If MIV is enabled,
Winmenu will notify the user and allow him to recall it or to execute another instance.
The default is ENABLED.

DisableRUN= When enabled (=1), the RUN window is disabled. The menu option can not
be accessed. the default is DISABLED. (The RUN window is enabled)

DisableLocalUpdates= This option allows you to "lock" online updates restricting the user
from changing or adding any menu item online. When enabled (=1) , Winmenu will
not allow the user to change any options nor add,change or delete any menu item. Use
only when such severe online restriction is desired. The default is DISABLED.

CacheALL= When enabled (=1), Winmenu will load all the authorized menu sections,
menu items and icons at startup to improve the response when the user changes from
one menu section to another. This is actually the default (enabled). You may disable
this command to improve the inital loading time specially if you have too many menu
sections and menu items for each user. Just enter a zero (=0) to disable the CacheALL
command. Disabling this command forces Winmenu to only load the menu section
selected by the user. Changing from one menu section to the other may take few
seconds when this command is disabled.

Sound= Disables (=0) or enables (=1) the sound effects. The default is enabled.
NOTE: If the user has no sound card installed, this parameter is ignored. Winmenu
comes with some of the sound files (.WAV) but not all that can be used. To use your own
.wav files, just copy them into the Winmenu directory but rename them to match the
names below. The following .WAV files can be used:

OPEN.WAV - If Winmenu was minimized and automatically restores the display.
SECURE.WAV - When user clicks on the "screen saver" button.
EXECUTE.WAV - Each time a program is executed from Winmenu.



WELCOME.WAV - When loading Winmenu
INCORREC.WAV - When displaying a message box.
MESSAGE.WAV - When new broadcast messages arrives to the workstation

OK.WAV - When the user makes any changes in the Options menu or the Sections
menu.

NOTE: Winmenu looks for these files in the directory where winmenu.exe resides. If not
found, no sound is produced. You need to have a sound card installed or the
SPEAKER.DRV .



Running Winmenu as the Windows shell

Make a backup of the file SYSTEM.INI which is found on your \WINDOWS directory.
Use your favorite text editor to load the SYSTEM.INI and look for the line that start with
SHELL=, modify the line to look like this:

SHELL=C:\WINMENU\WINMENU.EXE

Save the file!. The next time you run Windows, WINMENU will be
displayed instead of the Program Manager. If you ever decide to
restore the Program Manager, just modify the SHELL= line to look
like SHELL=PROGMAN.EXE and save it. Or restore SYSTEM.INI with
your backup copy.

Note: As a shell, Winmenu will automatically execute the startup group window as defined
in the Program manager. Also, the LOAD= and RUN= lines in the WIN.INI are executed as
startup.



The Menu Entry Dialog - administration

This window allow you to enter the basic information required to define an application. You
may also minimize Winmenu and use the File Manager to drag and drop applications into the
Winmenu ICON. For basic information on how to add new menu items, please see Menu
Lines

The Options button

The Menu Entry window provides additional capabilities for the administrator via the
Options button.  This button will expand the menu entry window to show three additional
fields :

Permission on: Please, look in the administrator's online file ADMIN.HLP for help with
AppVerify=_ under the [Options] section..

MAP= driveletter:=[fileserverName/volumeName:dirPath] USER=userid
PASSW=psw

(see Executing applications that reside in another filesever )

Limit count: You may enter the count of maximum users that can be allowed to execute
this application concurrently. This will help you control and force license agrements. A zero
or blank in this field allow unlimited users concurrently.



Executing applications that reside in another filesever

Winmenu provides the capability to log the user in and out of fileservers when executing
applications that do not reside in any of the attached file servers. This is specially useful

when using CDROM file servers where you might not afford to have a constant connection
for each user but need to allow them access to the applications .

L]

Click the "Options" button found in the Menu Entry dialog to display the optional features..
Note:. This button only shows when you are running Winmenu as the administrator .

L]

Tab to the MAP= field and enter the mapping information as follows:

driveletter:=[fileserverName/volumeName:dirPath] USER=userid
PASSW=psw

driveletter:= indicates the drive letter to use when mapping the resource. If used,
you must enter the driveletter followed by a colon ( : ) character and followed by the equal
(=) sign. Specifying a drive letter is optional. Winmenu can allocate the next unused
drive letter to map the resource if you do not specify a drive letter. Example:
O:=[MYSERVER/VOL1:] this will map the server MYSERVER and the volume VOL1 to the
drive O:

fileserverName = specify the fileserver name where the application resides. This
information is required. A open bracket ( [ ) character must precede the fileserver name.

volumeName = specify the volume name to map. Required. Most be preeceded by a
(/) character and followed by the ( : ) colon character. See examples below.

dirPath =Optionally, enter the path to map. Example O:=[MYSERVER/VOL1:APPS\]
This will map the path APPS\ from volume VOL1 of MYSERVER to the drive O: .

USER= holds the userid to login to the specified server.
PASSW= holds the login password
Valid examples:

O:=[MYSERVER/VOL1:] USER=GUEST PASSW=GUEST
[MYSERVER/VOL1:] USER=%SUSER% PASSW=%SPW%
[MYSERVER/VOL1:APPS] USER=GUEST PASSW=GUEST
[MYSERVER/VOL2:LINK\SHARE] USER=ALLUSERS PASSW=UNLOCK
I:=[MYSERVER/SYS:] USER=GUEST PASSW=GUEST
I:=[MYSERVER/SYS:BATCH] USER=GUEST PASSW=GUEST

=

The second example extracts the userid from the workstation environment variable SUSER=
and the password from the environment variable SPW=.






Changing the description of the pages

Each menu section has four pages represented by the "tab" buttons. The
default page description is "Page 1" through "Page 4". You may optionally
rename or delete each page description to further organize the menu items
for the selected section.

To rename the current page descriptions

Just, select the "Rename Pages.." option from the "Options" menu and do
the desired changes. User lower case letter whenever possible.

To delete a page for the selected menu section

Enter the word HIDE in the desired page field. Winmenu will not show the
page for the current selected menu section. NOTE: You should first delete
all the menu items in that page to save precious memory. The HIDE feature
do not deletes them.



Wconvert / for prior users

NOTE: If you are not upgrading Winmenu from a version prior to 5.0, you do
not need to read this section!.

Previous versions to Winmenu 5.0 used INI files to store the menu items
definitions. Starting with 5.0, Winmenu now stores the menu items in a
different file format with extension .GRP. These files are quite different
from the INI files. The most striking difference with the GRP files, is that
they can not be viewed or modified with a text editor. The GRP files can
only be modified online using Winmenu and the administration facility. The
problem with INI files in previous version was the side effect of slow loading
time when a lot of menu items and menu sections were defined. The main cause
of this side effect resided in the fact that Winemnu displays the ICON of each
application and was forced to physically extract this ICON at load time. This
is where the new GRP file format comes handy. The ICON is now extracted when
you define a menu item and it is stored in the .GRP file using a device-
independent format along with the menu item information. This has the effect
of releasing Winmenu from having to extract the ICON at load time and should
maintain an acceptable load time regardles of the amount of applications and
menu sections you are using. NOTE: The INI files are still used to store
other relevant information like configuration data and switches. For

each .GRP file, a corresponding INI filename may be automatically created for
this purpose.

&

If you are upgrading your copy of Winmenu from a version prior to 5.0, you
must convert the INI files into ..GRP file . This is accomplished by using
the utility program WCONVERT.EXE included with the Winmenu 5.x files. Just
follow the following steps:

1) Backup your current \WINMENU directory to a floppy or another dir.

2) Unzip or copy all your new Winmenu files in your current \WINMENU dir.
3) Print your current WINMENU.INI file . You will need it later.

4) Run your favorite text editor to create a new file. Do not use a Word
Processor. You may use NOTEPAD or EDIT

5) Enter the following lines in your text editor:

[WCONVERT]

INIFILEl=filename

INIFILE2=filename

INIFILE3=filename

etc.

where filename is the complete path+filename of each of your INI files that

holds menu items. You may look in the winmenu.ini file to find all the INI
files used. Up to 60 INIFILEx= lines may be processed by Wconvert.exe at
once. Example: assuming you have save the Winmenu files in your C:\WINMENU
directory...

[WCONVERT]

ConvertTO=GRP
INIFILE1=C:\WINMENU\GENERAL.INI
INIFILE2=C:\WINMENU\ACCT.INI
INIFILE3=C:\WINMENU\MANAGMNT.INI



INIFILE4=C:\WINMENU\WORDPRO.INI
etc.

=

Note: the line ConvertTO=GRP is optional when converting from INI to GRP file
format.. It indicates the destination format for the Wconvert routine.

6) Save the new file as WCONVERT.INI in the same directory where the new
Winmenu files resides. In other words, in your \WINMENU directory.

7) Run WCONVERT from Windows. Be sure you specify the full path + filename of
the wconvert.ini file in the command line parameter. Example:

WCONVERT C:\WINMENU\WCONVERT.INI

*You may also drag the file wconvert.ini and drop it on top of the program
wconvert.exe using File Manager.

Wconvert will display the progress of the convertion process as it executes.
For each INIFILEx= line., Wconvert will create a new .GRP file in the same
directory. The INI files are not destroyed or modified! If Wconvert ran
succesfully, you may execute the new version of Winmenu.exe.

NOTE: saving and executing the wconvert.ini file from the directory where the
Winmenu files reside is important because we want the new .GRP files to be
generated in that same directory.

t

WCONVERT MAY ALSO TRANSLATE BACK TO INI FILES!

This functionality may help you when doing massive changes to the menu
groups. You normally will use the online programs when adding and or changing
menu definitions. Nevertheless, there might be times when massive changes to
the menus are needed and you could use another approach for faster delivery.
Wconvert can translate .GRP files to INI files which can then modified using
your favorite text editor or other utility programs. The advantage is that you
may perform global search-and-replace functions to the INI files because they
are in text format. Once you have finished with your massive changes, you
must use Wconvert again to translate the INI files back to .GRP files.

&

NOTE: It is strongly recommended to backup your .GRP and .INI files before
doing any massive changes to them!. In fact, you should periodically backup
these files as standard procedure. A simple copy to a floppy disk may take few
seconds and save you a lot of time in case of a power interruption or any
other problem that may occur while using Wconvert. Remember also that for
each GRP file, there might exist a corresponding INI file in the same
directory.

To convert the GRP files to INI files

Just add the line ConvertTo=INI under the [WCONVERT] section in your
Wconvert.ini file. Example:

[WCONVERT]



ConvertTO=INI
INIFILE1=C:\WINMENU\GENERAL.INI
INIFILE2=C:\WINMENU\ACCT.INI
INIFILE3=C:\WINMENU\MANAGMNT.INI
INIFILE4=C:\WINMENU\WORDPRO.INI

The above example will convert the .GRP files to INI files. Wconvert
automatically ignores the .INI extensions in the above example because the
ConvertTo= command indicates the destination extension and Wconvert
automatically computes the source file extension. Since the destination file
extension is .INI, Wconvert figures that it must find .GRP files. In other
words, you do not need to change the lines above to have the extension .GRP
because Wconvert is smart enough to figure that out. To translate the .INI
files back to .GRP files, just change the line ConvertTO=INI to ConvertTO=GRP
and re-execute Wconvert. Check the screen messages and the file log that
Wconverts creates for errors. If Wconvert was interrupted, just restart. If
Wconvert can not translate for some reason, restore the .GRP files from your
backup!



Turn"yellow windows" ON/OFF
A yellow window is a small windows that automatically shows up when you leave the cursor
over any of the accessory buttons. These yellow windows help you identify the

corresponding accessory buttons by displaying the button description. You may turn the
yellow windows on or off as desired from the menu.







